
The Pull of Polaris: GIS & the Underground Rail Rd
 

Summary 
Using primary documents/slave narratives and GIS, the Pull of Polaris is designed to help students
learn to use GIS as they study the routes used by enslaved people who fled from the South to
freedom in the North with the help of the Underground Railroad.
 

Background for Teachers 
The geographic data presented in the ArcLesson include: (1) a base map of the eastern US, (2)
southern and northern cities--that were either avoided or crucial connections for a slave escaping
slavery via the Underground railroad—and (3) eastern rivers, typically critical pathways on the journey
toward freedom.
The file titled Pull of Polaris Instructions contains the directions for the GIS component of a complete
unit on the Underground Railroad. Support documents for the rest of the Underground Railroad unit
are located in the unit overview and the scoring rubric documents.
Before students begin this lesson, they need to—

Be assigned to their groups (if they will be working collaboratively)
Have read one of the slave narratives, making note of place names that are mentioned.
Have map use skills for looking up places mentioned in the slave narratives. Atlases and road
maps of the United States need to be available so students can find places mentioned and so
they can determine the latitude and longitude of these places.

The three narratives included in the file Slave Narratives are from Benjamin Drew (ed.), The Refugee:
Narratives of Fugitive Slaves in Canada Related by Themselves (Boston, 1856), pages 260-270, 276-
280, 301-305, 314-320. They are testimonies of former enslaved people who told their stories of
escape to Benjamine Drew.
The narratives found in the Pull of Polaris lesson were scanned and converted to HTML by Harry
Schulte Albers for The American Revolution, an .HTML project. According to information found on the
site,
"Benjamin Drew, a Boston abolitionist acting in cooperation with officers of the Canadian Anti-Slavery
Society, visited various towns of Upper Canada around the middle 1850's, interviewing scores of
refugees from the slave states and copying their words soon after they were spoken. For reasons of
safety, he protected the identity of his informants and used fictitious names. There were about 30,000
Negroes at that time in Upper, Canada, mostly adults who had once been slaves. John P. Jewett, the
prominent abolitionist-minded publisher of Boston who had unexpectedly reaped a fortune from
printing Uncle Tom's Cabin in 1852, vouched for the integrity and intelligence of Drew."
(The References section at the end of the Pull of Polaris Instructions document includes a list of web
sites and books where more slave narratives can be found. Be advised that the narratives we
included are just excerpts from more lengthy works. If you have advanced students or if you want to
present complete texts for your students to use, we suggest that you obtain copies of the unabridged
slave narratives.)
To do this lesson, the teacher needs to know--

the lesson is designed as a beginning GIS project for middle school students.
the teacher (or technology resource person) is expected to have some basic familiarity with
moving around in the ArcView environment as described below.

The theme titled Transparent US needs to be turned on after the student has added elevations to the
map.
Load the elevation shape file, "elev48.shp," from the web, or f you have a copy of the GIS K-12 CD,
the "elev48.shp" file can be loaded from the "d" drive.
To download the 1.2mb (=.7mb zipped) version go to http://www.esri.com/industries/k-

http://www.esri.com/industries/k-12/material.html#Mdat


12/material.html#Mdat.
(Remember: ArcView stacks information in the Table of Contents. Make sure to position the 
Transparent US theme above the Elevation theme so that the states will be visible when opened.)
N.B.:
The Northern Cities and Southern Cities themes were created from a shape file of 1990s Urban
Centers. The shapes that appear on the map when you open the Underground Railroad project are
NOT the urban areas that were present during the time of the underground railroad. Why, then, are
they used?

In part 2 of the project, students are required to map routes that were used to get slaves out of
the south to freedom in Canada. To limit the number of "dot" symbols on the map, urban areas 
are shown as irregular, large colored polygons. Dots are added to the map as students mark
stops along the slave's journey north; each dotted location being referred to in journal writings.
Many times routes went through cities, and some students may want to let a journal entry be
from a city. It is hard to distinguish dots laid over dots!

 

Instructional Procedures 
Introduction:  
The Underground Railroad was NOT a real railroad and it was NOT underground. The Underground
Railroad was a secret travel network developed to help blacks escape from slavery in the southern
United States in the years between 1800-1860. On their way to freedom, fugitive black "passengers"
were helped by "conductors" who moved them between safe places called "stations." Thousands of
enslaved people found freedom thanks to this very REAL network. Generally speaking, organized
"rail" pathways did not exist in the southern states; the formal underground network began at the
border states of Iowa, Illinois, Indiana, Ohio, and Pennsylvania.
Many of the enslaved people who decided to flee bondage in the South simply located and followed
the North Star, Polaris, and began a long, lonely trip to the free states.
Background:

It is estimated that as many as 100,000 individuals escaped from slavery during the decades
preceding the Civil War.
Fugitive slaves had limited knowledge about where they were going or how long it would take
them to reach freedom.
The blacks fleeing slavery tended to avoid cities in the southern states.
There were two major routes by which the fugitives traveled: (1)north through Kentucky into Ohio
and (2) north along the eastern seaboard into Canada. These routes required the fugitives to
travel through swamps, along riverbeds, across rivers, and over mountains.
The runaways depended on food they hunted or gathered in the wild and on food given to them
by other blacks they might encounter along the way.

From 1850 to the beginning of the Civil War, in accordance with the Fugitive Slave Law all citizens in
the US were obligated to report/return a fugitive enslaved person. This meant that even if a formerly
enslaved person were living in the free North, he or she could be captured and returned to slavery.
Consequently, the Underground Railroad's route ended in Canada! Canadian officials refused US
demands to return escaped slaves, and by 1860 40,000 to 50,000 blacks lived there. In Canada they
were considered free people and were allowed to vote and own property.
Star Facts:  
If a fugitive could find Polaris, then he or she could determine the direction to travel when escaping
the South. Polaris is the star that is always in the northern sky. But where is Polaris in a sky full of
stars? The answer to this puzzle is the constellation we call the Big Dipper--the constellation that the
enslaved Africans usually called the Drinking Gourd. The "cup" at the end of the Big Dipper points
toward Polaris. Polaris is the last star at the end of the ladle of the Little Dipper!

http://www.esri.com/industries/k-12/material.html#Mdat


The GIS PROJECT:  
Over the years, many people have researched primary documents to identify the passengers,
conductors, and safe places that made up the Underground Railroad. Because of its secret nature, it
has been very hard to map the actual routes that were used.
Your job is to use ArcView 3.2 GIS software to recreate a route that might have been used by an
enslaved person who was fleeing slavery with the help of the Underground Railroad.
Lesson 1 --Getting Started: Learning to use ArcView Tools
( N.B.: Before students begin the lesson, it should be opened and all necessary themes should be
added. Directions for opening the project and for adding themes are found in the READ ME file in the
Underground Railroad ArcLesson folder.)
Step 1 --Become familiar with ArcView terms and tools:  
Review the View tools and terms you will need for your first activities:
Table of Contents (left side of the View window) shows the range of themes open for use. Each item
shown in the Table of Contents is called a theme. Turn a theme on (which makes it "active") by
clicking the box to the left of the theme's name.
To see what the map looks like with a theme OFF, click the check mark. (When the check mark
vanishes, the theme is turned OFF.)
Identify tool is a circle with a lower-case-"i" inside. After you have highlighted a theme by clicking on
its name, you can use the Identify tool to find out information about selected features. (To highlight a
theme, move your cursor, which appears as an arrow inside the Table of Contents , to the theme's
name and click one time.) 
Step 2 --Locating Cities  
Cities of the South: In the South, if an escaping enslaved person were found, he or she would be
returned to slavery. This made it dangerous for runaway slaves to go near large populations of
people. Generally they avoided cities in the South as they headed north.
Highlight the theme titled "southern cities," then select the Identify tool. With the Identify tool selected,
you will be able to find out information about southern cities. Drag the Identify tool to one of the
southern cities and click. A table will appear that includes the name of the city at the selected
location. (Watch the numbers in the upper right hand part of the display, just above the colored bar.
The top number shows LONGITUDE (ignore the minus sign), and the bottom number shows
LATITUDE. All latitudes on this map are NORTH, and all LONGITUDES on this map are WEST.)
Using the Identify tool, determine which southern cities are at the following degrees of latitude and
longitude. When you have identified the southern cities at each point of latitude and longitude, record
the city names in the blank beside the coordinates.
37.52 0 North, 77.44 0 West __________________________
36.16 0 North, 86.78 0 West __________________________
30.03 0 North, 90.10 0 West .__________________________
32.39 0 North, 86.38 0 West __________________________
32.79 0 North, 79.95 0 West __________________________
34.75 0 North, 92.36 0 West __________________________
35.05 0 North, 89.90 0 West __________________________
Cities of the North: The following cities were known to be safe havens where runaway slaves might
find help from the Underground Railroad.
Highlight the theme titled "northern cities" by moving the cursor to the name "northern cities" in the 
Table of Contents. Click one time on the name.
Then select the Identify tool. Move the Identify tool to each of the following locations and click. Record
names of all the cities at the latitudes and longitudes given.
40.03 0 North, 75.03 0 West _________________________
42.09 0 North, 80.05 0 West _________________________



39.98 0 North, 82.92 0 West _________________________
43.19 0 North, 77.69 0 West _________________________
39.78 0 North, 86.13 0 West _________________________
42.34 0 North, 77.11 0 West _________________________
Step 3--Locating and Labeling Rivers  
Slaves often used water as part of their escape routes. Many times slaves traveled on or along rivers
to reach freedom. Many times they had to cross rivers to get out of the South. Let's investigate a few
of the major eastern rivers the slaved might have encountered.
Highlight the theme titled "Eastern Rivers" in the Table of Contents. It will resemble this:
Then click on the Open Theme Table tool. (To move the Table to the side so that you can read the
map, click on the bar at the top of the Table, and drag it off to the side.
Scroll through the table and select the following rivers. (To select a river from the table, simply click
on the name.)
Mississippi River  
Alabama River  
Savannah River  
Chattahoochee River  
Ohio River
After you have selected a river from the list, its color changes from blue to yellow on the map!
Some of the rivers form borders between states. Some of them run through states. Describe the
relative locations of each of the rivers listed above. ("Relative location" means where a place, person,
or thing is in relation to other features.) Using complete sentences, answer these questions about
each river.
Does the river form a border between states? If so, which states?
Does the river run through any state(s)? If so, which state(s)?
1: The Mississippi River
___________________________________________
___________________________________________
___________________________________________
2: The Alabama River
___________________________________________
___________________________________________
___________________________________________
3: The Savannah River
___________________________________________
___________________________________________
___________________________________________
4: The Chattahoochee River
___________________________________________
___________________________________________
___________________________________________
5: The Ohio River
___________________________________________
___________________________________________
___________________________________________
When you have finished this section, unselect the rivers by clicking on the Clear Selected Features 
icon. It looks like a piece of notebook paper that does not have anything written on it.
Now you will begin to build your base map.  
Label all five rivers  



Click on the Label button. Move the Label icon to the Mississippi River and click once. The river's
name will appear, and there will be dark boxes around the name. It is in "edit" mode, and it is time to
change the size and font of the river's name.Go to the menu names at the top of the project. Click on
the name Window, and open the menu by clicking on it. Go to the selection called Show Symbol
Window. An edit screen with many options will appear. Change the size of the name to 12. (If you
like, change the font to an italic style. Usually river names are italicized on maps.)
When you have done this, click on the Pointer button on the tool bottom tool bar.Move the Pointer 
tool to the box around the river name that was just edited. Keeping the Pointer tool showing, click
near the boxes around the river's name, and the edit box will disappear.
Labeling States  
Use the slave narrative you have read to determine the southern state where your story begins and
one other key state where the story takes place. You will be labeling these states on your base map.
Highlight the Eastern US theme.  
Go to the bottom tool bar at the top of the project and select the Label tool again.  
Now move the Label icon to the southern state where the slave's story begins. Click on the state, and
its name will appear.  
Now go again to the menu named Window, and open the menu by clicking on it.  
Again select the Show Symbol Window: change the size to 12.
Now select the Pointer tool and move it to the box around the state name that was just edited.
Keeping the Pointer tool icon showing, click near the boxes around the river's name, and the edit box
will disappear.
Label the northern state in the same fashion.
Step 4--Working with Elevation  
Because fugitive slaves had to cross terrain that was not familiar to them, see if you can determine
why it was important to know some basic facts about topography and elevation.
Highlight the theme titled "elev48.shp."Turn it on by clicking in the square box to the left of the title.
The map of the US will become colored and will resemble this map:
1. On your base map, how does elevation relate to directions the rivers flow?
___________________________________________
___________________________________________
___________________________________________
2. At what elevations do you find most of cities?
___________________________________________
___________________________________________
___________________________________________
3. How many southern cities are located
on rivers? __________
on coasts? __________
4. How many northern cities are located
on rivers? _________
on coasts? _________
on the Great Lakes? ______
When you have finished this lesson, go to the names above the tool bars and click on the File menu.
When choices appear, select Save Project As… and contact one of the teachers or the technology
assistant to help you! (Your project will be saved on a disk or on the c drive for you.)
Lesson 2 --Route to Freedom
Scenario  
You are a house slave who has made the decision to risk the dangers of escape in the hope of
reaching freedom in Canada. In order to pass the route of your journey on to your descendants, you



have decided to create a map.
You received one of the slave narratives copied from the World Wide Web. (For web addresses, see
RESOURCES at the end of this lesson.)
Step 1--Open the project  
Open Underground Railroad project (UndergroundRR.apr).
Turn on the elevation theme, titled "elev48" by clicking in the square next to its name.
Step 2: Locating Journal stopping points

Refer to the slave narrative you were given by your teacher. Determine the closest southern city
to where your journey begins from the selection shown on the GIS map.
Compile a list of all the geographic references made in the document. You will be adding this
information to your base map.

Stops on the Journey: Using an atlas, determine longitude and latitude for 10 places traveled to by
the escaping enslaved person. The stops made might not all be determined from the primary
information because some narratives might not specify ten stops.
Go back to the Drawing and Editing Button on the tool bar. Select the Dot.  
Go to the Window menu, click, opening the selections. Select the Show Symbol Window.  
From the top icons, select the one that is 3 rd from the left--the stick pin.  
Now select the first symbol that is a circle with a green center by clicking on it.  
Change its size to 6. Go to the top bar and select the paint brush. Change the color to medium
purple.
Close the Symbol Window and move the Drawing and Editing tool onto the map. (A crossed symbol
will appear.)
YOU MUST SELECT 10 LOCATIONS along your path for journal entries. Each of these places has to
be marked with a dot. You MUST record the latitude and longitude of each dot you draw. (Remember
to find the latitude and longitude, look in the upper right hand side of the project, just above the
colored bar.
Locate Journal Stopping Points

__________________________
__________________________
__________________________
__________________________
__________________________
__________________________
__________________________
__________________________
__________________________

__________________________
Step 3--Drawing the route  
Your will begin your journey to freedom from near one of the southern cities. (Starting areas will vary
depending on the slave narratives being used.)
While you are in the South:  
You MUST stay at least 20 miles from all cities except your city of origin.  
You MUST stay below 2,400 ft. elevation
Select the Drawing and Editing tool from the bottom tool bar. Open the drop down choices, and by
clicking and holding the button. Select the zig zag line, the 3 rd choice down.
Go to the Window menu, click and hold down to display the selections. Select Show Symbol Window.
Select size and change it to 2. Go to the paint brush and select it. Now choose a deep purple for the
color.
Begin to draw your route, using the Drawing and Editing tool. (If you make a mistake and want to



delete some of your route, go to the Edit menu, and open it by clicking on it. Select Delete Graphics.)
Remember, you MUST stay at least 20 miles from all southern cities. To measure distances, go to the
 Measure button on the bottom tool bar. It looks like a ruler, and it is usually found next to the hand
icon.
Move the Measure tool onto the map; it will appear as a ruler with a cross bar against it. When you
reach a city close to your path, click on it and then move the ruler and cross bars to your path. The
distance between the city and the path will show up on the bottom left-hand corner of your map. It is
called Segment Length, and you can see the length of the distance in miles. Double click and the
segment line will disappear.
When you reach the free states of the North:
Use the slave narrative to select your route, making it as historically accurate as possible.
In your journal record the names and the latitude and longitude for each city you enter.
Remember, you must get into Canada to have escaped.
Give the latitude and longitude for a northern city you travel through on your journey: City Name:
____________________; __________Latitude ________Longitude
Step 4: Printing the Map using Layout Mode  
Save your project by selecting the Save button from the tool bar!.
Now minimize the saved project, using the underscore mark at the top right-hand side of the screen.
From the Table of Contents, click on Layout, and double click on Underground Railroad. This will
draw out a map with a Title, a North Arrow, a Scale, and a Legend. Now add your name in a Text 
box.
To use the Text box, click on the Label icon, until the selection is available. Click on the Rectangle 
with a T in it. Then click somewhere on the lower right hand side of your map. When the window
called Text Properties appears, write in your name and click OK.
You can move the box that now has your name in it by clicking and holding the box and dragging it to
the desired location.
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